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Chapter

Overview

This tutorial covers how to perform co-simulation between RecurDyn and Particleworks. In
this tutorial, co-simulation is performed on the dynamic interaction between the flexible
bodies of RecurDyn and the fluid particles of Particleworks.

The model that will be covered in this tutorial is the Styler mechanism. The Styler is used to
shake off the dust attached to cloth and to remove its wrinkles with steam. This tutorial
analyzes the dynamic interaction between the clothes, which is expressed as a flexible body,
and the steam, which is expressed as particles. After the co-simulation, we will also check the
stress formed as the particles touch the flexible body, using the Contour function of
RecurDyn.

Task Objectives

This tutorial covers the following topics:

= How to export *.wall files of rigid and flexible bodies in a RecurDyn model
* How to create particles in Particleworks

= How to set fluid properties in Particleworks

» How to perform co-simulation in RecurDyn

* How to perform post-processing in RecurDyn
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Prerequisites

* This tutorial is intended for users who have completed the basic tutorials provided with
RecurDyn. If you have not completed these tutorials, then you should complete them
before proceeding with this tutorial.

» Particleworks software must be installed to proceed with this tutorial. This tutorial was
created based on Particleworks 6.2.0.

» In this tutorial, the analysis was carried out using the NVIDIA GeForce GTX TITAN
graphics card. Depending on the specifications of the computer and the version of the
software, there may be slight differences in the results of the analysis.

Tasks

This tutorial consists of the following tasks. The following table outlines the time required to
complete each task.

(* The time required may vary depending on the specifications of the computer and the
proficiency of the user.)

Task Duration
(minutes)
Registering Particleworks GUI on the RecurDyn 10
Ribbon
Modifying a RecurDyn Model 10
Creating a Particleworks Model 15
Co-simulation 10
RecurDyn Post-processing 5
Total 50
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Chapter

Register Particleworks GUI
in RecurDyn

By default, the External SPI (Particleworks) GUI is not visible in the RecurDyn. You must
add the GUI to RecurDyn using the configuration XML file provided by Particleworks.

Task Objective

Learn how to register External SPI(Particleworks) tab in RecurDyn ribbon using the
configuration XML and to set a particle solver DLL.

w

<’ Estimated Time to Complete

10 minutes
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Copy Configuration XML
To copy Particleworks.xml:

Copy the Particleworks.xml from install path of Particleworks software.

» <Particleworks Install Path>\module\Particleworks.xml

To paste XML in RecurDyn:

Paste the Particleworks.xml copied above to RecurDyn install path.
» <RecurDyn Install Path>\Bin\Solver\CoSim\StdParticleInterface\Particleworks.xml

To confirm RecurDyn GUI:

Run RecurDyn and check a ribbon GUI, you can see the External SPI tab and there is a
Particleworks group.

A~ |0 [0 =] =) & |- RecurDyn VR4 - [Mo
Home SubEntity Analysis Professional Flexible Post Analysis T5G DriveTrain Colink AutoDesign Communicator External SPI
. . . .

',"ﬁ., !"‘ e T =% ? ,? M %i3 ﬁ - w

£ i i A o . 1 "2 45

l “% r:% Ll b b [ - b J’\_&‘: " o
Walls Export Settings | Connect Contour Trace Mass Profile Sensors  Animation Clip Contour

Particleworks Post-Process

To check a path of particle solver DLL:

Must check where particle solver DLL file should be located.

1. From the Paticleworks group in the External SPI tab, click Settings.
2. In the Settings dialog box, click the Info.

Info x

Mame |Partic|eworks |

Developer |Prometech Software, Inc, |

Description A computational fluid dynamics solver based on Moving Particle Sim

DLL Path I ChPrometech\Particleworks_6.2.0_181221\module\Particlewarks.dll I

Output [Outputird_pw_%.8d |
| oK | | Cancel |

You can check the DLL Path in the Info dialog window. This path is set to the default
installation location of Particleworks. So, if you installed Particleworks in a different path,
you must modify the DLL path in the Configuration XML file.
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Tip: Modifying the Particle Solver DLL path in Configuration XML file

(Perform it when the DLL path in the Info dialog window is different from the Particleworks
installation path.)

1. Open the Particleworks.xml file.
2. Maodify the DLL path following <Path> as shown below.

<?xml version="1.0"7?>
e first letters of names of elements are capitalized and names of attributes are v

Any element for which support is opticonal must have the attribute "supported” with t
If there are multiple supported options of an element, then the element can have an
The names of elements in this file cannot be changed. —-->
<1— Configuration : reguired -->
=quires the attribute "type" and "version"-->

R
The value of the attribute "type" must be "Embedded" or "Independent” -->
<!—— External particle solwvers sh
E<C01f1garatlou type="Independent" wver

d use 'type="Independent"'. —->
sion="1010">

2 !—— Details : regqured —->
<Details>
<!—— Name : reguired -->
<!'—— This text will be used as the name of Ribbon Group icon in RecurDyn to ident

<Name>Particleworks<,/Names>

<1—— Developer : optional -->
<Developer>Prometech Software, Inc.</Developer:

<!—— Description : optional -—->
<Description>-A computational fluid dynamics solver based on Moving Particle Simml

<l—— Path : required -->

<'-— The path of the dll that BD will Joad to conpect to the particle solver —->
<Path>C:\Prometech\Particleworks 6.2.0_181221\modunle\Particleworks.dl1l</Path>

PSP | S S

3. Save the Configuration XML file.

4. After confirming that the Configuration XML has been modified successfully, restart
RecurDyn.
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Chapter

Modifying a RecurDyn Model

Task Objectives

In this chapter, you will learn how to create a flexible wall for analysis and how to export the
necessary files in Particleworks.

)

3

Estimated Time to Complete This Task

10 minutes
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Defining a patch set
For co-simulation between flexible bodies and particles of Particleworks, the portion of the

flexible body that contacts the particles must be defined as a patch set.

1. Open the Styler_flex_model_cloth_start.rdyn file that was provided as an example
model for this tutorial.

2. Enter the Edit mode of the Cloth_FE body.

i 4 Groups [—S——
=) Bodies
-4 Ground T
 Outer_Tank
=0
=@ Joints Eroperty
-G F\xa| Edit
@ Tl Delete
~F Forces ErEm
3: E;:::: Apply Cutting Plane
-] Reques Automatic
=y Splines Wireframe
; ES Shade
L, PRC Shade With Wire
=% PVC Hide
L PVCTYTT
AB Strings
- P B
& Ex_motion
d..} USUB

3. In the Set group of the FFlex Edit tab, click Patch.

. 4. When the Patch Set dialog box appears, click the Add/Remove button.

Patch
Patch Set [ Current Unit : N/kg/m/s/deg ]

External Patch Set

| | Add/Remove ||

| Add/Remove [Continuous) | Tolerance [Degree]

|:| Check Reverse Direction

5. Select all patches by dragging them,
right-click the mouse, and click Finish
Operation.

Click the OK button.

Finish Operation

Translate

Rotate

(2

g 7. Exit the Edit mode.

[
o

Zoom

O MA o B

View Center

Exit

v

Select Zoom

Fit F

s

View Control »

Rendering Mode »

&b Current Directory O

10
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Creating walls
Create walls for Outer_Tank and Cloth_FE.

1.
2.
3.

In the Particleworks group of the External SPI tab, click Walls.
In the Working Window, click Outer_Tank.
Click Walls again, and click Cloth_FE.SetPatch1l in the Working Window.

Tip: You can select Cloth_FE by using Select Box or Select List, which are existing
methods for selecting internal bodies. In this model, however, Outer_Tank is set as the
layer 2 in a multi-layer. So, if you press “Ctrl + 2", which is a shortcut key combination
for Layer hide/show, Outer_Tank will be hidden so that you can choose inner Cloth_FE
more easily.

Modify the names of the walls as follows:
=  Walll > Wall_Outer_Tank
=  Wall2 > Wall_Cloth_FE

Exporting a *.wall file

1.
2.

In the Particleworks group of the External SPI tab, click Export.

When the Export dialog box appears, locate the folder you want to save the file to and
click OK to save it.

The rd_pw.wall file and the WallGeometries folder are created in the saved folder.
The files created in this chapter are moved to the Particleworks project folder in
Chapter 4.

TIP: If you want to save the rd_pw.wall file somewhere else, you may do so. Pressing
the Export button and clicking OK immediately saves the file in the default folder where
the rdyn files are saved.

Note: The rd_pw.wall file contains information about the position and orientation of
wall geometries. If you import this file into Particleworks later, several wall
geometries are imported at once. In the Wall Geometries folder, the files (*.obj or *.stl)
related to wall geometry are automatically saved.

Save and exit RecurDyn.

11
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Chapter

Creating a Particleworks Model

Task Objectives

In this chapter, you can import wall files from Particleworks and create fluid particles by using
inflow as a model for steam.

3

Y
"/ Estimated Time to Complete This Task

15 minutes

)

12
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Starting Particleworks

Create a new model

m 1. Double-click the Particleworks icon on the Desktop.

@ 2. When you click New Project on the File tab, the New Project dialog box appears.

Steps Choose Project
1. Choose Project Q, Filter:
2.

Categories: Projects:

14 @ Empty project
Cescription:
Ernpty Particleworks project
< Back Finish Cancel Help
Click Next.

In the Project Name field, type Styler_simulation.

In the Project Location field, enter the location where the project will be created.

AN

Click Finish to create the new model.

Copying a RecurDyn model and wall-related files

= In order for both software to perform co-simulation, the RecurDyn model and the Wall file
must be in the Particleworks project folder.

= Move the Styler_flex_model_cloth_start.rdyn file, rd_pw.wall file, and WallGeometries
folder you used in Chapter 3 to the scene folder in the folder where the Particleworks
project was created. (Folder path: <Project Location>/Styler_simulation/scene)

13
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Configuring a preprocess

Import a wall file

PW Wizard = =
1. Double-click the scene folder in the Projects Styler_simulation > [} scene
dialog box. Objects Mml.'_l"
, - “Model RS
% 2. Click Start wizard.
= Inflove Iriflow:
The PW Wizard dialog box appears on the right. = 0utflow Rectangle
A i =IFll Circle
3. Click the Open button to import the rd_pw.wall =Y — ——

file.
<Project Location>/Styler_simulation/scene/rd_pw.wall

F,le 4. Click the Fit button and the +Z plane button at the top of the Working Window to
(Fa view the imported wall.

As shown on the left, you can check whether the Wall_Cloth_FE.obj and
- Wall_Outer_Tank.obj are properly imported into the scene tree and check the shape
of the imported wall files as shown on the right.

Files |0utline |Projects x | - Styler_simulation - scene X| ¥ o
= —— R
IQ Styler_simulation g, Iﬁ_lx @x @Y @Y @Z @:‘ Ak Jp
+[W% Models
~+10 scene 0.000 s (000)
=B Input ' s (000)

@ damain
=B gravity

LT W/ all_Outer_Tank,obj
""" 3 Result

@ clipping
“Ed ruler
=-E3 YWidgets
J-, Al
ﬂ Color bar
~® Time

14
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Set Wall_Outer_Tank.obj transparency

You need to adjust the transparency because the inner cloth is not visible due to
Outer_Tank.

1. In the Projects dialog box, double-click Wall_Outer_Tank.obj under scene > Input.

The Object dialog box associated with the entity you Key Frames | Object X | Physics =
clicked is shown in the figure to the right. Wall_Outer-Tank ob] [ Hide
Parent |@ Mone - I

Location|0 ¢y |0 i |0 fm)
2. Change the Alpha value in the Appearance panel to 0.2 Rotaton [0 (5 [0 (o |0 (5
and press Enter. Center [0 ()0 ()0 (m))E3

Wall_Outer_Tank.obj becomes transparent, allowing v Model
you to look its inside. Model| | 0 Wall_Outer_Tank,obj  ~ | ..,

¥ Appearance

Mode | Solid v
| #pha 0.2 |
Z Order 0

Clip hd

Configure the camera

The default GUI setting of Particleworks is Turn Table, which is inconvenient to use.
Switch the setting to a Track ball so that you can rotate it conveniently.

1. In the Projects dialog box, double-click Camera | KeyFrames |oObject % | Physics -
under scene > View. W0 camera Hide
The Object dialog box associated with the entity ~ Camera
you clicked is shown in the figure to the right. Parent @ Hone y

2. Change the Rotation Mode to Track Ball. IHntatiDn Mode |Track Ball | I

Eve Location 127356 (| 48266 (n 02554 ¢
Target Location 012e-8 | 098 () 0 ()

Up Yector 0.0514452) 0,993689 | 009957
Ortha Il

Mear 01 imy

Far 10000 ¢ rry 3




STYLER (FLEX-PARTICLEWORKS)

Set a domain

Domain is the area where fluid particles are analyzed. When the particles used as the steam
fall down to the bottom, a reservoir at the bottom receives the water particles in the actual
Styler. However, this analysis does not need to simulate the particles entering the reservoir.
So, we will use a domain to delete the particles that fall down to the bottom.

1. In the Projects dialog box, double-click a domain under scene > Input.
2. Set the size of the domain as follows.
= Upper limit: 0.3, 1.96, 0.3

* Lower limit: -0.3, 0.55, -0.3

Key Frames | Object X | Physics | =
£ domain [ Hide

0.000 s (000)

* Transform

Parent @ Mone v
Lacation 0 iy | 0255 my [0
Dimensions 0.6 () [ 141 i) (06 (m)

¥ Damain

Upper limit| 0.3y | L95 (oy ( 03 (o
Lower limit) -0,3 (055 (| 003 (o

&djust domain
domain

Create an inflow

Inflow is a function that lets particles flow to the user-defined zone at the user-defined speed
or flux.

1. In the PW Wizard dialog box, click the Circle button six times.

In the Projects dialog box, six inflows are created in scene > Input.

PW Wizard X | - Files | Outline | Projects | -
[ Styler_simulation > [ scene —@ Styler_sim ~
Objects Model: & +|-'lj| FModels
=IModel L -@ scene
W3l _Cloth_FE, obj Inflow: B2 Input
Wall_Outer_Tank, obj Rectangle <2 domain
=l\rflow Circle I $ gravity
B inflaw Donut ~&# Wall_Cloth_com, obj
3> inflowe_1 Open.., calig Aol Hopsion com.obj
B> inflow_2 outlom - (3>
B> inflow_3 Rectra - inflow_t
(> inflow_4 Circls - inflaw_2
(> inflow_5 Open - inflow_3
= Outfl o 99 inflow_d
Sl Fill: Gg inflaw_5
=IMiscellaneaus Fill =-1=3 Result W

16
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Double-click every inflow created in the Projects dialog box one by one to set the option
values in the Object dialog box as shown below.

Width and Height are set to the following values for all inflows.

»  Width: 0.1

* Height: 0.1
inflow

= Location: 0.2, 1.73, 0.16

* Rotation: 0, -90, 15
Inflow_1

= Location: 0.2, 1.73, -0.04

* Rotation: 0, -90, 15
Inflow_2

= Location: 0.2, 1.73, -0.24

= Rotation: 0, -90, 15
Inflow_3

= Location: -0.2, 1.73, 0.24

= Rotation: 0, 90, -15
Inflow_4

= Location: -0.2, 1.73, 0.04

= Rotation: 0, 90, -15
Inflow_5

= Location: -0.2, 1.73, -
0.16

* Rotation: 0, 90, -15

After confirming that the inflows are well
defined as shown in the figure on the right,
click the Next button in the PW Wizard
dialog box to proceed to the next page.

(> inflow (group: 2) [ Hide
 Transform ~
Parent  |@ Mone v
Location| 0.2 ¢y | 173 () |06 (m)
Rotation |0 ¢y =90 (= |15 =
Center |0 (my|0  (myf0 (| Ed
Type Circle ~
Width |01 i)

Height |01 ()

(> inflow_2 (group: 4) [ Hide
« Transform ~
Parent | @ Mane v
Location| 0.2 ¢y | 173 () | 0024 (m)
Rotation |0 =y | =90 (= |15 =
Center 0 (my|0  (m)|0  (m) €3
Type Circle v
Width |01 )

Height |01 (m)

(> inflow_d (group: B [ Hide
* Transfarm A
Parent | @ Mone v
Location| -0.2 ¢y | 173 (| 004 i
Rotation |0 =y 180 ¢y | -15 (=)
Center |0 (mi| 0 ()| 0 () || &2
Type Circle w

Width |01 ()
Height |01 ()

(> inflow_1 {group: 3 [ Hide
* Transform ol
Parent | @ MNone v
Location 02 ¢y | 13 iy | 004 ¢
Faotation |0 = | -80 (= (16 (=
Center |0 (m|0 (|0  (m))ES
Type Circle w
Width 01 o

Height |01 im)

B> inflow_3 (group: B [ Hide
* Transform £
Parent |@ Mone v
Location| -0.2 ¢y | L3 (o | 024 iy
Ratation | 0 [ L e LR
Center |0 (m[0 (m0 (3
Type Circle ~
Width |01 ()

Height |01 ()

(> inflow_5 (group: 7 [ Hide
~ Transform ~
Farent @ Mone -
Location| -0.2 ¢y | 173 () | <016 ()
Rotation |0 ¢=y 1890 =y | -15 (=)
Center |0 ()0 ()0 (m) E3
Type Circle w

Width |01 i)
Height |01 ()

17
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Create and configure physical properties

1. At the bottom of the PW Wizard dialog box, click PW Wizard X -
Manage physical properties.... _ Gulnslmleion o | 8 G
Objects Physical propery ~
EItodel
&% Wall_Cloth_FE.obj | Mone
&% Wall_Cuter_Tank,ob None
Elnflow
e':'inflow MNone
9'>inflow_l MNone
9—)im‘|0w-2 MNone
9—)im‘|0w-3 MNone
eéinflow_fi MNone
B inflow_5 Mone
I 0utflow
EIFill v
I Manage physical properties., .. I
< Back MNext > Execute Close

2. When the Physical property manager dialog box appears, click the + button to create
a fluid.

The basic physical property of the generated fluid is water. So you can use it as is.
3. Click the + button again to create a polygon.
Polygon is a physical property that specifies the rigid or flexible body defined as a wall by
RecurDyn.
€5 Physical property manager >

General |nteractions

& Fluid

—— Mame Polygon
& Folygon Thermal Boundary | &diabatic v
Thermal Conductivity 50 (W /- 1)

Young's Modulus 1 (GPa)
Paoizson Ratio 1]
Harnaker Constant 10 20 g

Surface Roughness |0 m

Save Cancel

4. Click the Save button to close the dialog box.

18
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5. In the PW Wizard dialog box, change the physical Pwizarg x| -
properties from None to the values specified below. B Syler-simulaton > [ scene

Objects Physical property
= Wall_Cloth_FE.obj: Polygon TModal
&% Wall_Cloth_FE. bj
» Wall_Outer_Tank.obj: Polygon  Wall_Outer_Tank
=lnflow
= All inflows: Fluid 0 inflow
B inflaw_1
> inflow_2
> inflow_3
B inflow_4
(> inflow_5
=I0utflow
=IFil

Manage physical properies...,

< Back Execute Close

6. In the Physics tab of every inflow, set the value for |[kevframes [obicct [pnysics x| =
Emit Velocity as shown below. 2 e 3 Fide

= Physical Property ~

= Emit Velocity: 1

Type & Fluid “

¥ Fhysical Property Yalues

* Details
Emit Mode Yelocity ~
| Emit Velocity 1 imys) |
Linner |irnit 1000 ooz N
7. In the Physics tab of Wall_Cloth_FE.obj, check KeyFrames |Object |Physics x| -
Double-sided DF and set the Thickness of Polygon as & Wall_Cloth_FE. abj (group: 1) [ Hide
follows. v Physical Property
= Thickness of Polygon:1 Tvee (o Palvgon -

» Physical Propery VYalues
* Details

. ® ., OFlowResi,, O.. O Outflow,,,
Initial Temperature 0 (o)

Particle Margin 0.9

Double-sided DF

Thickness of Polygon| 1

Srmaath DF O

Bubble Generation O

8. Click the Next button at the bottom of the PW Wizard dialog box to proceed to the
next page.

19
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Configure particles and preferences

In the PW Wizard dialog box, change the + Preprocess Settings

preferences. Coordinate Systern Y ~
1. In the Particle Size field, enter 0.01. Ipanicle Size 001 (m)

2. Click Next to proceed to the next page. Auto Grid Interval

Flow Resistance Res, | 0.5

Note: In the case of SPI, the unit in Particleworks must be set to meter regardless
of the unit in RecurDyn. If the unit in RecurDyn is set to meter, you don't need to
convert the particle size or domain size and you just need to use the same values in
Particleworks. If the unit in RecurDyn is set to millimeter, you need to convert the
millimeter values to the meter values and enter the meter values in Particleworks.

3. IntheY field of the Gravity pane, enter '9.8, jUSt like [ Styler_simulation > [ scene

in RecurDyn. - Gravity
4. Set the Viscosity option as shown below. sray 0 (nyet) [98 yen]o ven
.. ¥ Pressure
=  Type: Implicit Tove [FRiGR -
5. Leave the others at the default settings and click Mode| Stabilized i
Next. ~ Yiscosity
6. On the Thermal page, press Next without changing I;if: 'Ir“D"C" 2l

any of the default values.

¥ Surface Tension

Type Mone w
¥ Turbulence

Type Mone w

Configure analysis conditions

Set the analysis options in the PW Wizard dialog Styler_sim_mm > [14] scene

box. .
w Time -
1. In the Time pane, enter 0.0005 in the st T B
Initial dt[s] field. nish_Time s
_ _ { Initial dt | 0,0005 ) |
2. Enter 0.01 in the File Output Interval
Time[s] field. = Quiput Settings
Forrnat vB
Precision d.. =
Typa si,., ~
File Qutput Interval Time 0.0 s
File Output Skip ]
Load / Torque Type 5. w

20
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Create particles

1.

Basic settings (1. from 2)

@
In the PW Wizard dialog box, Stops
click the Execute button when 1. Basic settings
you have finished all the % Simulaton setins
settings.

The Run dialog box appears.

Set the Run option to
Preprocess.

Click Execute.

If the message saying that the
particle creation is completed
appears in the Output dialog
box as shown below, the

Fun:

() Simulation

(O Preprocess & Simulation

CPU cores: 1= (8 cores available) License, .,
GRU: 0: GeForce GTX TITAN
Precision: Double

Single

particles have been created.

Cutput - Styler_simulation - scene (Preprocess) X | Player

T9-02-T5TIE 32 44 TWFO 0:0 |

19-02-15T16:42:44 [NFO 0:0 ] 90 % has been finished

19-02-15T16:42:44 INFO 0:0 ] 100 % has been finished

19-02-15T16:42: 44 INFO 0:0 ] DOF successful ly generated

19-02-15T16:42:45 INFO 0:0 ] Preprocess successful ly completed
| 13-02-13716:42:45 INFO 0:0 ] Normal end, |

80 % has been finished

< Back Cancel Help
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Preparing for Co-simulation

To do co-simulation in RecurDyn, you need to create some files in Particleworks. The relevant
files are automatically generated by Particleworks as you go through the standalone analysis.

Perform standalone analysis in Particleworks.

1. On the Simulation tab, click Run. | @ Eofeuimisten - sna x

. . . Steps Basic i (1. from 2)
2. Set the Run option to Simulation. 1 Basic seltings

2. Preprocess settings Run: () Preprocess

3. Enter the number of CPU cores to | =~ ™™=
be used for the analysis.

() Preprocess & Simulation

CPU cores: 15 (8 cores available) License,.,

If there is a GPU, select the GPU to

be used for the analysis. &P
4. Click Next.

Precision: O Double

@ Single
5. Check Close without running | € Run.. [styler simulaton - scene] x
s|mu|at|0n . Steps Simulation settings (2. from 2)
1, Basic settings .
6 CIICk Execute 2. Simulation settings Command Line:

CHPrometech®Particleworks 6. 2. 0_181221% rmodulettapp. solver float e
we -k cuda -g 0 -p, - resultsub.json -n 1

Additional options:

] Resume 0z Last frame

(O Mormal execution
(O Launch external pracess

® Close without ranning simulatior I

< Back Mext > II Cancel Help

7. Save the project.

The Particleworks program may be turned off in Chapter 5. However, in this tutorial, we

will proceed to the next chapter with the program turned on to check the analysis results in
real time during analysis.
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Chapter

Co-simulation

Task Objectives

In this chapter, we will perform co-simulation using RecurDyn and Particleworks to analyze
the interaction between flexible bodies and particles.

"/ Estimated Time to Complete This Task

10 minutes

BN,
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Co-simulation

Perform co-simulation in RecurDyn

1. Run RecurDyn and open the Styler_flex_model_cloth_start.rdyn file you copied in
Chapter 4.
(File path: <Project Location>/
Styler_simulation/scene/Styler_flex_model_cloth_start.rdyn)

2. In the Simulation Type group of the Analysis tab, click Dyn/Kin to open the

@ Dynamic/Kinematic Analysis dialog box.

Dyn/Kin 3. Check the simulation end time and step. Dynamic/Kinematic Analysis x
n End Time: 1 General |pParameter | Initial Condition
- Step: 500 End Time |'I |

Plot Multiplier Step Factor 1.

] output File Name | |

rInclude
[ static Analysis

|:| Eigenvalue Analysis
[ state Matrix

|:| Frequency Response Analysis

Hide RecurDyn during Simulation

Display Animation

Gravity
’7 ¥ |0. | v |-9806.55 | z |0. ||Gra\rity|
Unit | Mewton - Kilogram - Millimeter - Second |
Export RSS | Simulate | | oK | | Cancel |

4. Click Simulate to perform the analysis.

Tip: Some of the options in the Dynamic/Kinematic Analysis dialog box are as follows.
= End Time: Defines the simulation duration.
= Step: Defines the number of frames that are saved during the entire simulation duration.

* Plot Multiplier Step Factor: Defines the number of saved data points for plotting. The
number of plot data points is defined by multiplying Step by Plot Multiplier Step Factor.
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Chapter

Checking the Analysis Results

Task Objectives

In this chapter, we will check how particles affect a flexible body using Contour.

N

3

¥
Estimated Time to Complete This Task

5 minutes
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Checking Contour

After the analysis is completed, you can check the result using Contour to see whether the
particles affect the flexible body. And since we do not actually model the exact physical
properties and interactions of the fabric, the values from the stress or reaction force are not
exact experimental values. So please check only whether the flexible body is affected by the
particles.

1. In the FFlex group of the Flex tab, click Contour.

2. In the Contour dialog box, set the Type to User Defined and click the Calculation
button.

A Contour x

r Contour Option ———————— ~Band Option  View / Reference Node / Reference Marker

oaton oot [ || [

Type Stress

Component SMISES. [7] show Text Legend
[l pisplay vector  [175.954155715775 Band Level{10~50)
4 wm ]
Uniform DS\mpIe
D [ Style Option
Contact Surface Only
D ¥ Colar Option Edit r Contour Data Trace
(®) User defined contact surface
Sel Bod: Mode ID
Speaum [ !
() Contact patches only
Style Stepped -]
— Min/Max QOption
Text Color Text Color -

Type || User Defined

Exceed Max Color Max Color 7

Kl

Less than Min Color Min Color - | Add | | Delete
| Calculation |
Calc. Result —User Defined —  Contour Element Set Selection
Min || ol [ o Contour Part
Max || o[l 2|

[show Min/Max [ ]Enable Log Scale

D User Defined Max Color

[Juser Defined Min Color [ Mesh Lines Line Color | - | | || Add | Delete
Enab\e Contour View
—— | —cr——

3. Change the Max value of User Defined to 2 and click OK.

p 4. Inthe Animation Control group of the Analysis tab, click the Play button to see
Contour.

Thanks for participating in this tutorial
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